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Chapter 1

Implementation Process

Implementation Overview
The Vivado™ Design Suite enables implementation of Xilinx® 7 series FPGA designs from a 
variety of design sources, such as RTL designs, netlist designs, and IP centric design flows, 
as illustrated in Figure 1-1. For a complete understanding of the different design flows 
supported by the Vivado tools, refer to the Vivado Design Suite User Guide: Design Flows 
Overview (UG892). Vivado implementation encompasses all of the design steps required to 
place and route the netlist onto the FPGA device resources while meeting the logical, 
physical, and timing constraints of the design. 

Vivado implementation is a timing-driven flow with native support of industry standard 
Synopsys Design Constraints (SDC) commands to specify design requirements and 
restrictions. Xilinx has added additional commands in the Xilinx Design Constraints format 
(XDC). 

X-Ref Target - Figure 1-1

Figure 1‐1: Vivado Design Suite High‐Level Design Flow
Implementation www.xilinx.com 5
UG904 (v2012.2) August 20, 2012

http://www.xilinx.com


Implementation Overview
The Vivado implementation process includes logical as well as physical transformations of 
the design, and consists of the following sub-processes:

1. Opt Design: Optimize the logical design to make it easier to fit into the target Xilinx 
FPGA.

2. Power Opt Design: Optionally optimize elements of the design to reduce power 
demands of the implemented FPGA.

3. Place Design: Place the design onto the target Xilinx device. 

4. Phys Opt Design: Optionally optimize the timing of the design by replicating drivers of 
high-fanout nets to distribute the loads.

5. Route Design: Route the design onto the target Xilinx device. 

6. Write Bitstream: Generate a bitstream for Xilinx device configuration. 

The complete design flow is integrated within the Vivado Integrated Design Environment 
(IDE) which provides a standardized interface called the Flow Navigator to assemble, 
implement and validate the design and IP of the FPGA design. The Flow Navigator provides 
a push-button interface to the entire implementation process, as shown in Figure 1-2, to 
simplify the design flow. This guide does not provide a detailed examination of the Vivado 
IDE, except as it applies to implementation. For a complete understanding of the Vivado IDE 
as it relates to the entire FPGA design flow, refer to the Vivado Design Suite User Guide: 
Using the Integrated Design Environment (UG893). 

 

Vivado design tools also provide a tool command language (Tcl) application programming 
interface (API). The Tcl API enables scripting support for all design flows, allowing you to 
customize the design flow to meet your specif ic requirements.

X-Ref Target - Figure 1-2

Figure 1‐2: Flow Navigator ‐ Implementation Section
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Getting to Implementation
Getting to Implementation
The Vivado Design Suite offers a variety of design flows, and supports an array of design 
sources. However, to get to a bitstream that can be downloaded into an FPGA, the design 
must pass through implementation. This is a series of steps that takes the logical netlist and 
maps it into the physical array of the target Xilinx device. These steps include logic 
optimization, placement of logic cells, and routing of connections between cells. The 
following section describes what is needed to get your design into implementation in the 
Vivado Design Suite. 

Project and Non‐Project Modes

The Vivado tools let you create a project f ile (.xpr), and directory structure, to manage the 
design source files, store the results of different synthesis and implementation runs, and 
track the project status through the design flow. However, the Vivado Design Suite also let 
you work strictly in memory, without the need for a project f ile and local directory. 

In Project Mode, or a Project-based design, a directory structure is created on disk to help 
you manage design sources, run results, and project status. The automated management of 
the design data, process and status requires a project infrastructure which is stored in the 
Vivado project f ile (.xpr). In addition, the Project Mode automatically writes checkpoint f iles 
into the local project directory at key points in the design flow. 

Working without a project f ile, in the compilation style flow, is referred to as Non-Project 
Mode, or the Non-Project batch flow. A powerful feature of the Non-Project Mode is the 
ability to work with the design in memory. Source f iles and design constraints are read into 
memory from their current locations, and the in-memory design is stepped through the 
design flow without having to be written to intermediate f iles. In Non-Project Mode, you 
must run each design step individually and set design parameters and implementation 
options using Tcl commands. You can apply design changes and proceed through the 
design flow without having to save changes and rerun steps. You can run reports and save 
design checkpoints (.dcp) at any stage of the design flow. 

IMPORTANT: In Non-Project Mode, when you exit the Vivado design tools, the in-memory 
design is lost. For this reason, you should write design checkpoints after major steps such as 
synthesis, placement, or routing. 

You can save design checkpoints in both Project Mode and Non-Project Mode. You can only 
read design checkpoints in Non-Project mode. 

There are many distinctions between Project Mode and Non-Project Mode in the Vivado 
Design Suite. Vivado implementation can be run using either project-based designs, or 
non-project based designs. The Vivado IDE and Tcl API can also be used with both 
Implementation www.xilinx.com 7
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Getting to Implementation
project-based, and non-project based designs. However, some of the features of the Vivado 
IDE, and Vivado implementation, are not available in Non-Project Mode: (1) 

• Flow Navigator

• Design status indicators

• IP integration

• Implementation Runs and Run Strategies

• Design Runs window

• Messages window

• Reports window

You must implement the non-project based design by running the individual Tcl commands: 
opt_design, place_design, and route_design. You can run implementation steps 
interactively in the Tcl Console or the Vivado IDE, or by using a custom Tcl script. You can 
also customize the design flow as needed to include reporting commands and additional 
optimizations. See Running Implementation in Non-Project Mode, page 12. 

The details of running implementation in Project Mode and Non-Project Mode are 
described in this guide. However, for more information on running the Vivado Design Suite 
using either Project Mode or Non-Project Mode, refer to the Vivado Design Suite User 
Guide: Design Flows Overview (UG892) and Vivado Design Suite User Guide: Using the 
Integrated Design Environment (UG893).

RTL and Synthesized Design

You can use the Vivado Design Suite to manage the entire FPGA design process including 
RTL development, IP customization, synthesis, implementation through to programming 
and validating the device. You can add HDL sources such as Verilog, SystemVerilog, and 
VHDL f iles. You can add previously defined and configured (IP) cores from the Xilinx IP 
catalog. You can add digital signal processing (DSP) modules from System Generator, 
C-based DSP modules from Vivado High-level Synthesis (HLS), and embedded processor 
modules from Xilinx Platform Studio (XPS). 

Vivado Design Suite also supports netlist-driven design by importing previously 
synthesized netlists from Xilinx or third-party tools. The netlist input formats include 
structural Verilog or SystemVerilog, EDIF, or Xilinx NGC. For more information on the 
different source files and project types supported by the Vivado Design Suite, refer to 
Vivado Design Suite User Guide: System Design Entry (UG895). 

1. This list is representative of the features that are not supported in Non-Project Mode. It is not intended to be an 
exhaustive list.
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Getting to Implementation
At a minimum, Vivado implementation requires a synthesized netlist. A design can start 
from a synthesized netlist, or it can start from RTL source f iles. When starting from RTL 
sources, the Vivado synthesis, or XST, must be run before implementation can begin. The 
Vivado IDE will manage this automatically if you attempt to run implementation on an 
un-synthesized design, and give you the option to run synthesis f irst. For information on 
running Vivado synthesis, see the Vivado Design Suite User Guide: Synthesis (UG901). 

In non-Project Mode, you must use the Tcl command, synth_design, to create and open the 
synthesized design. You can also use the Tcl command, link_design, to open the design. See 
Opening the Synthesized Design in Chapter 2 for more information. 

In Project Mode, after synthesis of an RTL design, or with a netlist-based project open, you 
can load the design netlist prior to implementation. You can open a synthesized design 
using one of the following methods in the Vivado IDE:

• Select Flow > Open Synthesized Design from the main menu.

• In the Flow Navigator, select Open Synthesized Design from 
the Synthesis section.

• In the Design Runs window, using the Open Synthesized 
Design command from the popup menu.

IP Centric Design

The Vivado IP catalog feature lets you configure, implement, and verify IP. The IP can be 
configured and verif ied as a standalone module, or within the context of a larger system 
level design. 

The IP Catalog displays all available Xilinx LogicCORE™ IP, as well as any user-defined IP or 
third party IP that has been added to the catalog. The catalog includes data related to the 
IP type, version, datasheet, and license information. You can add an IP core to an RTL design 
by defining the instantiation template into the system-level design. IP is created as RTL 
sources, not netlists. Running synthesis and implementation will implement the IP along 
with the rest of the design. However, you can also synthesize the IP as a standalone module 
and add the netlist to a netlist design. The supported IP netlist formats include Xilinx 
formats (.xco, .xci, .ngc), Verilog (.v), and EDIF (.edf). For more information on how 
Vivado tools support IP centric design, refer to the Vivado Design Suite User Guide: IP 
Design (UG896).
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Getting to Implementation
Constraints

In addition to a synthesized netlist, design constraints should be provided to guide 
implementation. A constraint set is a set of constraints f iles, containing design constraints 
captured in XDC files, that can be applied to your design. There are two types of design 
constraints: 

• Physical constraints define pin placement, and absolute, or relative, placement of cells 
such as BRAMs, LUTs, and Flip Flops, and device configuration settings.

• Timing constraints, written in industry standard SDC, define the frequency 
requirements for the design. Without timing constraints, the Vivado Design Suite will 
optimize the design solely for wire length and routing congestion.

Note: Without timing constraints, Vivado implementation will make no effort to assess or 
improve the performance of the design. 

IMPORTANT: The Vivado Design Suite does not support the UCF format. For information on migrating 
UCF constraints to XDC commands refer to the Vivado Design Suite Migration Methodology Guide 
(UG912) for more information.

Within a constraint set, you can have multiple constraints f iles. You can have constraint sets 
with separate physical and timing constraint f iles. You can have a master constraints f ile, 
and direct design changes to a new constraints f ile. Separating constraints by function into 
different constraint f iles, can make your overall constraint strategy clearer, and facilitate 
targeting timing and implementation changes.

You can also have multiple constraint sets for a project, and make different constraint sets 
active for different implementation runs to test different approaches. You can have separate 
constraint sets for synthesis and for implementation. You can experiment by applying 
different constraints during synthesis, simulation, and implementation to help meet your 
design objectives. Organizing design constraints into multiple constraint sets can help you:

• Target different Xilinx FPGAs for the same project. Different physical and timing 
constraints may be needed for different target parts.

• Perform what-if design exploration. Using constraint sets to explore different scenarios 
for floorplanning and over-constraining the design.

• Manage constraint changes. Override master constraints with local changes in a 
separate constraint f ile. 

TIP: A good way to validate the timing constraints is to run the report_timing_summary 
command on the synthesized design. Problematic constraints should be fixed before implementation.

For more information on defining and working with constraints, see the Vivado Design Suite 
User Guide: Using Constraints (UG903).
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Getting to Implementation
Design Checkpoints

In addition to the design netlist and constraints, which provide inputs to the 
implementation process, the Vivado Design Suite uses a physical design database to store 
placement and routing data. The Vivado tools provide design checkpoint f iles (.dcp) as a 
mechanism to save and restore this physical database at key steps in the design flow. 
Checkpoints are merely a snapshot of a design at a specific point in the flow. 

The current netlist, including any optimizations made during implementation, the design 
constraints, and any implementation results, are stored in the design checkpoint f ile. 
Checkpoint designs can be run through the remainder of the design flow using Tcl 
commands, but cannot be modified with new design sources.

You can write and read checkpoint f iles using the following commands from the Vivado IDE:

• File > Write Checkpoint: Captures a snapshot of the design database at any stage in 
the flow. This creates a file with a .dcp f ile extension. The related Tcl command is 
write_checkpoint.

• File > Open Checkpoint: Opens the specified checkpoint in the Vivado Design Suite. 
The design checkpoint is opened as a separate project in the Vivado design tools, and 
can not be read into an existing project. The related Tcl command is 
read_checkpoint.
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Running Implementation in Non‐Project Mode
To implement the synthesized design or netlist onto the targeted Xilinx FPGA, you must run 
the netlist and the design constraints through a series of steps: optimization, placement, 
and routing, collectively known as implementation. 

In the Non-Project Mode, you must run implementation using a series of Tcl commands, or 
a Tcl script which defines the overall design flow. The Tcl commands can be entered into the 
Tcl Console from within the Vivado IDE, or can be entered from the Tcl prompt in the Vivado 
Design Suite Tcl shell. 

Non‐Project Mode Sample Script

The following script provides an example of running implementation in Non-Project Mode.

# Step 1: Read in top-level EDIF netlist from synthesis tool
read_edif c:/top.edf 
# Read in lower level IP core netlists
read_edif c:/core1.edf
read_edif c:/core2.edf 

# Step 2: Specify target device and link the netlists
# Merge lower level cores with top level into single design
link_design -part xc7k325tfbg900-1 -top top.edf

# Step 3: Read XDC constraints to specify timing requirements
read_xdc c:/top_timing.xdc 
# Read XDC constraints that specify physical constraints such as pin locations
read_xdc c:/top_physical.xdc 

# Step 4: Optimize the design with default settings
opt_design 

# Step 5: Place the design with effort level set to high
place_design -effort_level high 

# Step 6: Route the design with effort level set to high
route_design -effort_level high 

# Step 7: Run Timing Summary Report to see timing results
report_timing_summary -file post_route_timing.rpt 
# Run Utilization Report for device resource utilization
report_utilization -file post_route_utilization.rpt 

# Step 8: Write checkpoint to capture the design database; 
# The checkpoint can be used for design analysis in Vivado IDE or TCL API
write_checkpoint post_route.dcp 
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Running Implementation in Non‐Project Mode
Details of Sample Script

The key steps of the preceding script can be broken down as follows:

1. Read design source f iles. 

In this case the design sources are EDIF netlist f iles. However, the Non-Project Mode 
also supports an RTL design flow, reading source files and running synthesis prior to 
implementation. 

The read_* Tcl commands are designed for use with the Non-Project Mode, as it allows 
a f ile on the disk to be read by the Vivado Design Suite to build the in-memory design, 
without copying the f ile or creating a dependency on the file in any way. The advantages 
of this approach make the Non-Project Mode extremely flexible with regard to design. 
However, a limitation is that you are required to monitor any changes to the source 
design f iles, and to update the design accordingly.

2. Build the in-memory design.

In this example script, the Vivado tools build an in-memory view of the design using the 
link_design command. This command takes the netlist based source files read into 
the tool, and combine them with the Xilinx part information to create a design database 
in memory. All actions taken in the Non-Project Mode are directed at the in-memory 
database within the Vivado tools. 

The in-memory design resides in the Vivado tool, whether running in batch mode, Tcl 
shell mode for interactive Tcl commands, or in the Vivado IDE for interaction with the 
design data in a graphical form. 

3. Read design constraints.

The Vivado Design Suite uses design constraints to define requirements for both the 
physical and timing characteristics of the design, as explained in Constraints, page 10. 
The read_xdc command reads an XDC constraints f ile and applies it to the in-memory 
design. 

TIP: While the Project Mode supports the definition of constraint sets, containing multiple constraints 
files for different purposes, the Non-Project Mode uses multiple read_xdc commands to achieve the 
same effect. 

4. Perform Logic Optimization.

The example script performs logic optimization in preparation for placement and 
routing. The objective of optimization is to simplify the logic design before committing 
to physical resources on the target part. The Vivado logic optimizer provides many 
different types of optimizations to meet different design requirements. See Logic 
Optimization, page 44 for more information. 
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Running Implementation in Non‐Project Mode
5. Place the Basic Logic Elements.

The example script performs a general placement of the overall design. However, 
placement can also be accomplished in stages, according to the hierarchy of the design, 
or the complexity of the placement challenge. See Placement, page 47 for more 
information. 

6. Route the Design.

This command completes the required routing for the design. The Vivado router 
provides a general purpose route for all occasions, and also provides a great deal of 
control for re-entrant routing to complete challenging designs. See Routing, page 50 for 
more information. 

7. Run required reports.

The example script generates two of the many reports available from the Vivado Design 
Suite. In the Non-Project Mode, you must specify each of the commands you want to 
create, using the appropriate Tcl command. You can output reports to f iles, for later 
review, or you can direct the reports to the Vivado IDE for more interactive examination. 
See Viewing Implementation Reports, page 36 for more information. 

8. Save the Design Checkpoint prior to exiting the Vivado tool.

Finally, the example script saves the in-memory design, with its optimized netlist, the 
physical and timing related constraints, the Xilinx part data, and placement and routing 
information, into a design checkpoint f ile. In Non-Project Mode, the design checkpoint 
f ile saves the design and allows it to be reloaded for further analysis and modification. 
See Design Checkpoints, page 11 for more information.
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Running Implementation in Project Mode
In Project Mode, the Vivado IDE allows you to define implementation runs that are 
configured to use specific synthesis results and design constraints, and to run multiple 
strategies on a single design. You can also customize implementation strategies to meet 
specific design requirements, and save those strategies for use in other designs. 

IMPORTANT: The Non-Project Mode does not support predefined implementation runs and strategies. 
Non-project based designs must be manually moved through each step of the implementation process 
using Tcl commands. See Running Implementation in Non-Project Mode, page 12 for more information.

Creating Implementation Runs

You can create and launch new implementation runs to explore design alternatives and f ind 
the best results. You can queue and launch the runs serially, or in parallel using multiple 
local CPUs. On Linux systems, you can also launch runs on remote servers, see Appendix A, 
Using Remote Hosts.

An implementation run can be defined using one of the following methods:

• Select Flow > Create Runs from the main 
menu. 

• In the Flow Navigator, select Create 
Implementation Runs from the 
Implementation popup menu.

• In the Design Runs window, using the 
Create Runs command from the popup 
menu.

The Create New Runs wizard opens. The f irst page of the wizard is a summary of the 
command. Click Next to proceed.

Note: If you used Flow > Create Runs, you will need to select Implementation on the f irst page of 
the Create New Runs wizard. 

The Set-Up Implementation Runs dialog box opens, as shown in Figure 1-3, page 16.
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Running Implementation in Project Mode
 

1. Select a Synthesized netlist:

This lets you select a synthesis run that will be used to generate, or has already 
generated, the synthesized netlist to be implemented. Alternatively, you can select a 
synthesized netlist that was imported into the project from a third party synthesis tool. 
See the Vivado Design Suite User Guide: Synthesis (UG901) for more information. 

The default will be the currently active synthesis run in the Design Runs window, see 
Using the Design Runs window, page 19.

2. Select a Constraints set:

This specif ies the constraint set to apply during implementation. The optimization, 
placement, and routing are largely directed by the physical and timing constraints in the 
specified constraint set. See the Vivado Design Suite User Guide: Using Constraints 
(UG903) for more information.

3. Select a target Part: for the run. 

The default values for Constraints Set and Part are defined by the Project Settings at the 
time the Create New Runs command is run. See the Vivado Design Suite User Guide: 
Using the Integrated Design Environment (UG893) for more information on the Project 
Settings. 

X-Ref Target - Figure 1-3

Figure 1‐3: Create New Runs: Set Up Implementation Runs
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To create runs with different constraint sets or target parts, you must use the Create New 
Runs command. You can also change these values in the Run Properties window, by 
selecting the run in the Device Runs window as explained later. See Changing 
Implementation Run Settings, page 20. 

4. Click Next. 

The Choose Implementation Strategies dialog box opens, as shown in Figure 1-4. 

 

5. Enter a Name for the run, or accept the default name. 

6. Select a Strategy for the new run. 

The strategies are a defined set of Vivado implementation feature options controlling 
the implementation results. Vivado Design Suite offers a set of pre-defined strategies to 
select from, and you can also create your own implementation strategies. For more 
information see Defining Strategies, page 25. 

° Vivado Implementation Defaults: Balances runtime with trying to achieve timing 
closure. 

° HighEffort: Puts more focus on timing closure, with increased runtime. 

° HighEffortPhySynth: Increased focus on timing closure, with increased runtime. 
Enables physical synthesis after placement.

° LowEffort: Low placement and routing effort, useful for early implementation 
passes. 

X-Ref Target - Figure 1-4

Figure 1‐4: Choose Implementation Strategies
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Running Implementation in Project Mode
° QuickEffort: Non-timing driven place and route. This strategy ignores all timing 
constraints, and should only be used to evaluate the ability to place and route the 
unconstrained design.

Prior to launching a run, you can change the settings for each step in the 
implementation process, overriding the default settings for the selected strategy. You 
can also save those new settings as a new strategy. See Changing Implementation Run 
Settings, page 20 for more information. 

7. You can optionally choose Make Active for the run to make a new run the active run. If 
you are creating multiple new runs, only one run can be made the active run. The Vivado 
IDE will display run results information for the active run.

8. Click the More button to define additional runs. Specify names and strategies for the 
added runs as shown in Figure 1-4, page 17.

9. Click Next.

The Launch Options dialog box opens as shown in Implementation Launch Options, 
Figure 1-5, page 18. 

 

10. Specify the Launch Directory: to create and store the implementation run data. 

The default directory is contained within the local project directory structure. Files for 
implementation runs are stored by default at: 

<project_name>/<project_name>.runs/<run_name>

X-Ref Target - Figure 1-5

Figure 1‐5: Implementation Launch Options
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TIP: Defining a directory location outside of the project directory structure makes the project 
non-portable because absolute paths are written into the project files.

11. Specify the Launch Options:

° Launch Runs on Local Host: Launch the run on the local machine. 

- Number of Jobs: Define the number of local processors to use when launching 
multiple runs simultaneously. Individual runs are launched on each processor. 
Vivado does not support multi-threading for implementation.

° Launch Runs on Remote Hosts (Linux only): Use remote hosts to launch one or 
more jobs. See Appendix A, Using Remote Hosts.

- Configure Hosts: Select this option to configure remote hosts. 

° Generate scripts only: Export and create the run directory and run script, but do 
not launch the run at this time. The script can be run at a later time outside of the 
Vivado IDE tool.

° Do not launch now: Save the new runs, but do not launch or create run scripts at 
this time. 

12. Click Next and review the Create New Runs Summary.

13. Click Finish to create the defined runs and execute the specif ied launch options. 

New runs are added to the Design Runs window.

Using the Design Runs window

The Design Runs window displays all of the synthesis and implementation runs created in a 
project, and provides commands to configure, manage, and launch the runs. 

Select Window > Design Runs to open the Design Runs window if it is not already 
displayed. Figure 1-6, page 20 shows the Design Runs window.

Each implementation run appears indented beneath the synthesis run it is a child of. A 
synthesis run can have multiple implementation runs. You can expand and collapse 
synthesis runs using the tree widgets in the window. The Design Runs window is a tree table 
window. Refer to Design Suite User Guide: Using the Integrated Design Environment (UG893), 
for more information on working with the columns to sort the data in this window. 
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The Design Runs window reports the run status, including when the run has not been 
started, is in progress, is complete, or is out-of-date. Runs can become out-of-date when 
source files, constraints or project settings are modified. You can reset and delete stale run 
data in the Design Runs window.

Only one synthesis run and one implementation run can be “active” in the Vivado IDE at any 
time. All views in the Vivado IDE will reference the active run. The Log and Report views, 
Status Bar, and Project Summary display information for the active run. The Project 
Summary window only displays compilation, resource, and summary information for the 
active run. 

The active run is displayed with bold text. To make a run active, select the run in the Design 
Runs window and use the Make Active command from the popup menu.

Changing Implementation Run Settings

When you select a run in the Design Runs window, the Run Properties window displays the 
current configuration of the selected run, as shown in Figure 1-7. In the Run Properties 
window you can change:

• The Name of the run.

• The Xilinx Part targeted by the run.

• The run Description.

• The Constraints set that both drives the implementation and is the target of new 
constraints from implementation. 

See the Vivado Design Suite User Guide: Using the Integrated Design Environment (UG893 for 
more information on the Run Properties window. 

Figure 1‐6: Design Runs window 
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You can also change the options used by Vivado implementation features. Select a run in 
the Design Runs window, and use the Change Run Settings command from the popup 
menu to open the Design Run Settings dialog box, as shown in Figure 1-8, page 21. 

TIP: You can only change the settings for a run that has a Not Started status. You can use Reset Run 
to return a run to the Not Started status. See Resetting and Deleting Runs, page 23. 

 

Figure 1‐7:  Run Properties window

Figure 1‐8:  Design Run Settings
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The Design Run Settings dialog box displays the implementation strategy currently 
employed by the run, and the command options associated with that strategy for each step 
of the implementation process:

• Strategy: Select the strategy to use for the implementation run. Vivado Design Suite 
offers a set of pre-defined strategies to select from, and you can also create your own 
implementation strategies. For more information see Defining Strategies, page 25. 

• Description: Displays a textual description of the selected implementation strategy.

• Options: When you select a strategy, each step of the Vivado implementation process 
displays in a table in the lower part of the dialog box: opt_design, 
power_opt_design, place_design, phys_opt_design, route_design, and 
write_bitstream. 

When you click on the name of a specif ic command option, a brief description of the 
option displays at the bottom of the Design Run Settings dialog box. See Chapter 2, 
Implementation Commands for a detailed discussion of the different implementation 
steps, and their available options.

You can modify command options by clicking on the right-side column of a specific 
option to modify:

° Options with predefined settings can 
be selected from a pull down menu. 

° Options can be enabled or disabled by 
a check box. 

° Options accepting a user-defined 
value can be defined by typing a value. 

° Options accepting a file name and 
path will open a f ile browser dialog to 
let you locate and specify the file. 

° A custom Tcl script can also be inserted before (tcl.pre) and after (tcl.post) 
each step, allowing you to perform specif ic tasks either before or after the 
implementation step. An example of this would be to generate a timing report 
before and after Place Design to compare timing results. 

• Save Strategy As: This command, which appears as an icon next to the Strategy 
f ield, saves any changes to the strategy as a new strategy for future use. If you do 
not use the Save Strategy As command, any changes are saved to the current 
implementation run, but are not preserved for future use. 
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Understanding Run Status

The Vivado IDE processes the run, and launches implementation, depending on the status 
of the run. The status is displayed in the Design Runs window, as shown in Figure 1-6, 
page 20. If the status of the run is: 

• Not Started: The run will begin immediately. 

• Error: The Vivado IDE will f irst reset the run to remove any incomplete run data, and 
then will restart the run. 

• Complete (or Out-of-Date): The Vivado IDE will prompt you to confirm that the run 
should be reset prior to proceeding with the run.

Resetting and Deleting Runs

To reset a run, select a run in the Design Runs window, and select Reset Runs from the 
popup menu. Resetting an implementation run will return it to the f irst step of 
implementation, opt_design, for the selected run. 

 

The Vivado IDE will prompt you to confirm the Reset Runs command, and provide the 
option of deleting generated f iles from the run directory. The default setting is to delete the 
generated files. Disable this check box if you to preserve the generated run files for any 
reason. 

You can also delete runs from the Design Runs window by selecting the run, and selecting 
Delete from the popup menu. The Vivado IDE will prompt you to confirm the Delete Runs 
command, and provide the option of deleting generated files from the run directory. This is 
on by default.

 

X-Ref Target - Figure 1-9

Figure 1‐9: Reset Run

X-Ref Target - Figure 1-10

Figure 1‐10: Reset Run
Implementation www.xilinx.com 23
UG904 (v2012.2) August 20, 2012

http://www.xilinx.com


Running Implementation in Project Mode
Customizing Implementation Strategies

Implementation Settings define the default options used when defining new 
implementation runs. These options can be configured using the Vivado IDE. 

Figure 1-11, page 25 shows the Implementation Settings of the Project Settings dialog box. 
This dialog box can be accessed from the Vivado IDE by using the Tools > Project Settings 
command from the main menu. 

TIP: The Project Settings command is not available in the Vivado IDE when running in Non-Project 
Mode. In this case, you can define and preserve implementation strategies as Tcl scripts that can be 
used in batch mode, or interactively in the Vivado IDE.

Implementation Settings for the active implementation run 
can also be accessed directly from the Flow Navigator. 

The following fields are found in Implementation Settings:

• Default Constraint Set: Select the constraint set to be used by default for the 
implementation run. 

• Strategy: Select the strategy to use for the implementation run. Vivado Design Suite 
offers a set of pre-defined strategies to select from, and you can also create your own 
implementation strategies. For more information see Defining Strategies, page 25. 

• Save Strategy As: This command, which appears as an icon next to the Strategy 
f ield, saves any changes to the strategy as a new strategy for future use. 

• Description: Displays a textual description of the selected implementation strategy.

The description of Vivado tools standard implementation strategies cannot be changed. 
However, if you change the standard strategy, you will be offered the chance to save the 
new strategy, and change the description at that time. 

The description of user-defined strategies can be changed by entering a new 
description.
Implementation www.xilinx.com 24
UG904 (v2012.2) August 20, 2012

http://www.xilinx.com


Running Implementation in Project Mode
 

Defining Strategies

A strategy is a defined approach for resolving the synthesis or implementation challenges 
of the design. The strategy is defined in a pre-configured set of options for the Vivado 
implementation features. Strategies are tool and version specif ic. Each major release has 
version-specif ic strategies. 

Vivado implementation provides several commonly used strategies that are tested against 
internal benchmarks. Changes to the settings for predefined implementation strategies 
cannot be saved. However, you can copy and modify supplied strategies to create your own. 

The currently defined strategies can be accessed through the Vivado IDE from the Tools > 
Options command in the main menu. Figure Figure 1-12 shows the default strategies 
provided with the Vivado tools.

X-Ref Target - Figure 1-11

Figure 1‐11: Implementation Settings
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To review, copy, and modify strategies:

1. Select Tools > Options from the main menu. 

2. Select Strategies in the left-side panel. The Strategies dialog box, shown in Figure 1-12, 
page 26, contains a list of pre-defined strategies for different tools and release versions.

Figure 1‐12:  Default Implementation Strategies
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